PNet — Control software for Pumps,
Powder doser and Gas flow controller

LAMBDA Laboratory Instruments PNet Control Software
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Introduction

PNet is a PC control software for the control of LAMBDA laboratory instruments (peristaltic
pumps PRECIFLOW, MULTIFLOW, HIFLOW, MAXIFLOW, syringe pump VIT-FIT, powder
dosing instrument DOSER and gas flow controller MASSFLOW) and allows the program-
ming of set point profiles.

The laboratory instruments are connected to the computer through a RS-232 or RS-485 in-
terface. Then, the COM port to which the instrument is connected and its address are select-
ed.

Up to 12 Pumps, 16 Massflow gas flow controllers, 36 Integrators can be connected and
managed simultaneously.

If other functions are needed, you can make contact with us (support@lambda-
instruments.com). If possible, we will integrate the desired functions in your software system,
in such a way that it conforms optimally to your specifications.

Hints

An automation system should make the work easier. Before initiating the process, think of a
guestion: what will happen in the event of a system failure (e.g. an interface, measuring ap-
paratus or PC breaking down)? Experimental set up should be made to have a minimal effect
due to breakdown and the system should be safe.

For example:

- Appropriate valves are opened or closed automatically during power cut.

- Pumps should not be overloaded.

- Before leaving the program, switch all apparatus to the “Zero” position.

- Your equipment must be capable of withstanding the most extreme possible condi-
tions placed on it. (Example: For pressure regulation, your apparatus should be able
to tolerate the maximum pressure allowed by the safety valve).

- To avoid overheating of electronic circuits, nothing should ever be placed on the D/A
converter box.

Text convention
Italic: words which appear in the program, like menu, text on buttons (example: OK)

Any extension cards that may be required (RS232, RS485, etc...) can then be installed. To
do this, it is necessary to exit PNet (Lea version 5.6), shut down Windows and switch the
computer off.

If a RS232/RS485 converter is to be used, this can also be connected at this time.

To install PNet (LEA version 5.6) insert the CD-ROM into the CD-ROM drive and start the
set-up program 'Setup.exe’'.

Finally switch the various devices on, boot the computer and start PNet (Lea version 5.6).
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The software is provided with an example configuration file based on your requirement. You
could use it or build your own application.

Please refer the user manual of SIAM (http://lambda-instruments.com/pdf/SIAM _Industrial-
Fermentation-Software-User-Manual.pdf) to know more about the procedure to generate a
visual configuration of your own which can be saved and reopened later.

A short video of the program configuration can be found at:
http://www.youtube.com/watch?v=K aVvQQgqQw

Opening the program configuration file

To open the present configuration file example, select the Open command in the File menu
and choose Open to open the configuration file PeristalticPump2xConfiguration.cfg.

An example configuration for 2 pumps will appear.

| ‘W LEASSE-PNet i a lecule(Eh ’.. Open T —ﬁ=‘—‘ﬁ
[[File] Configuration Windows Help | O@q » Computer » Local Disk(C) » PNet v [ 49 | Search Prer

Open... N ‘
Save Organize v New folder = (0 @

Save as... | i# Dropbox
™ nas

Print
| Printerconfiguration... @ SkyDrive

|

| A Libraries

| % Recent Places

Peristaitic Pump | Peristaltic Pump | Pumpdx startstop vitfit 1x
1x x profile.cfg configuration.cfg
L8] Documents configuration.cfg | configuration.cfg L
& Music
&= Pictures

B videos

| () (e S R Eor <
H‘ ar, Sk (=) % Computer
&, Local Disk (C) vitfit 1x vitfit2x vitfit2x with vitfitdx with
= — - profile.cfg configuration.cfg profile.cfg profile.cfg

File name: Peristaltic Pump 2x 6 - [c on (*.cfg) -

( VOpen%'v]‘ Cancel |

General description of the program window
While opening the program configuration file, a window opens with a possibility to

- Send a set point to the pump

- Configure, start or stop a flow profile

- Save the data

- Visualize and compare the data as trends
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Peristaltic Pump 1 Peristaltic Pump 2
Pump address: 10 Pump address: 11
Set value Set value
- Flow profile configuration
Pump Profile 1 Pump Profilc 2
- . I = Profile start/ stop
opt| » | 14 E]LL':'—__> Profile reset
] B > Frofilevalue
e W Integrator value
Run Reset Run | Resetl
e 5= Integratorreset
Save Data > Integrator start
[None] - Data saving configuration
EonfiJ_ I On { > Data saving - start/ stop

To enter a new set point value of the pump click on the input field. A second field is displayed
into which the new target value can be entered. Press the Enter key to confirm the entry. If
the value is outside the calibration limit, it will not be accepted by the system.

wl
4

To close the field without change press the Escape key. The target value can be changed
using the scrolling arrow. The change steps correspond to 1/1000 of the displayed interval.

Set COM port and instrument address

To initiate the communication with the instrument, the software needs to know the address of
the device and the COM port which is used to connect the instrument to the computer.

These parameters can be changed only when the configuration mode is activated.

Choose the command Enter in the menu Configuration and enter the password “lea” in the
dialog box. The program is now in configuration mode.

A Lea 5.6-PNet [Peristaltic Pump 2x configuration.cfg] - [Synoptic5] [F=mE ) f! Lea 5.6-PNet [Peristaltic Pump 2x configuration.cfg] - [SynopticS] = 8] 8
11 File Edition [Configuration| Windows Help -8 x B File Ediion Configuration Wind Helf
Enter.. [\ | Uz | W
‘ Peristaltic Pump 1| Peristaltic Pump 2 2 2 U Peristaltic Pump 1 Peristaltic Pump 2 2 B X}
PumpSet! Qttet PumpSet!  IntegrQttel Pus
Pump address: 10 Pump address: 11
Set value Set value 310, g0 ! g0
Pump Profile 1 Pump Profile 2 g g ~~~~~~~~~~~ g
£ 2 £
. Frs| §7 $:s
opt| > | 14 opt| » | 14 §7‘ b v N X Concel | ] ‘é"
_— —_— 2] ——
S
Integrator 1 Integrator 2 Integrator 1 Integrator 2
L I 2l 2 — = =
_un [ rese| ) “un [N fosel Crun | ese

In the menu Configuration, select Device Configuration, Pump and click on Pumpl.
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A new dialog box titled ‘Configuration for a Lambda pump’ will appear. Select the COM Port
to which the device is connected. Please refer the video
http://www.youtube.com/watch?v=fCQX7vRp9aY for setting up and checking the COM port
number on PC.

B} Lea 56PNt Permiolic Purp 2 oumstionchl Diropeel = I Lea 5.6-Pet Perisaltic PUf i o . B %
By File Edition (Configuration | Windows Help - & X B Fie Edtion Configur]| [ Dovce
Device configuration » Pump » Pumpl [\ i Pump1
Perista Visual components Massflow » Pump2 : Peristaltic Pund| COM ot "{QMZ g Slave address |6
Communication visualisation Integrator » Pump 3 ggmg -
Pump|  Bit di/dtfunction  » Reps Pump address: 1 S
Pump 5 Channels COMS &
I .| o e Ok coue
S COM?7
Vol Seti  Pulsfunction » RuheD Punplocail || Z0M7
u Profile » Pump? | Set value COM3 -
Pump8
Pump Profile 1 PumpF  Program » ump Pump Profile 1
i § et Pump9
Pump 10
UD“ > e Opt| » | 14 o
ot > | 14
Sl slele) letel o
Pump12
i [
s s
Integrator 2 Infomation
Integrator 1 g Integrator 1 [
Run | Reset _Run | Reset|
V0K X Annles

Set address of the pump (refer to http://www.lambda-
instruments.com/?pages=peristaltic pump preciflow remote control#pc-control for the
pump address).

Click on the Connected check box to initiate communication between the PC and the device.
Close the dialog box with OK.

The message ‘Unknown COM error’ or ‘Timeout’ will appear if the software cannot communi-
cate with the pump. In this case check the COM port and the address on the pump and
whether the cable is well connected.

B Leo 5.6-PNet [Peristaltic Pull e omiguiation h'aimb“am ot

Configuration for a Lambda pump SN

2 ) Lea 5.6-PNet [Peristaltic Pu 2
3
B9 Fie Edition Configurafl)| | Device ng ¢ d 9 Device:
R Nome [Pl
Peristaltic Punf| COMPot CoM2 =] Slave addess [10 = Peristaltic Pu COMPot  |COM2 =] Slave addess |10
W Comedied v Comeded
Pump address: I Pump address: 1 I T
PumpLocall | PumpSet! 52| | PumpSetl
Set value — T
Pump Profile 1 ‘0 Unknown LM error
opt » | 14 [ Annuter
LIEE] = [Camier
| -
Infomation Infomation
Integrator 1 l Integrator 1 \
Ak X Annuler 0K X Annules

The Description field displays the internal device name. The Information field is free for user
input.

Repeat the same procedure for connecting Pump 2, 3, etc and the Integrator to the PC con-
trol software.

A Please note that the address of the pump and its internal integrator (option-
al) is the same.
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Programming the flow profile

USER MANUAL

In the Configuration menu click the command Device configuration and select Profilel for

pump 1.
A Le2 56-PNet [Perisaltic Pump 2 configuration.fg] - [Synoptic] el A Lez 55-PNet [Peristaltic Pump 2x configuration.cfg] - [Synoptics] C=ILE
| g File Edition [Configuration | Windows _Help 11 File Edition (Configuration | Windows _Help & x|
| Device configuration » Pump » S ‘ Device configuration »| Pump » - ‘
Perista  Visual components Massflow | R R 4 Perista  Visual components Massflow |2 2 K] |
Communication yisalisation Integrator Fi QUL ReEtnE T Communication visualisation Integrator » [poSet! lnigrattel PumpSet2
Pump|  Exit df/dt function » Pump|  Exit df/dt function >
_—. - Timer » -. - Timer »
Set value Set | :“Ij FCIEED e 3 et vaioe - Ger|  Pulsfunction » =
ofile N » - | Profil » Profile1... d
Pump Profile 1 PumpF  Program © > g Pump Profile 1 PumpF‘ p.:;.m » pmm:z,,, D‘
N % i § s » Profile3...
opt| » | 1« opt| w14 é-’“ ?” ﬂjﬂ ,ikl »|1e Profiled...
. : Profies..
Profile7...
Integrator 1 Integrator 2 Integrator 1 Integrator 2 Profiles...
un e Profile10...
_pon || e B = 7n [ vese n | s
Dialogue box titled Configuration for profile will open.
Configuration for profile 5
Device Profile. prf
Name Profile1
Begin End Time (HHH:MM:SS) | »
Linked channet 1 0 100 000:03:58 @
[Pumpsen ;] 2 100 300 000:09:53
3 300 500 000:05:00
Channels 2 500 600 000:024i0
StartProfiel I ResetProfilel ProﬁleVduell 5 0 0 000:00:00
3 0 0 000:00:00
Description 7 0 0 000:00:00
Profile1 8 0 0 000:00:00
5 9 0 0 000:00:00
Information
10 0 0 000:00:00
n 0 0 000:00:00 -
Remarks
‘ 0K X Cancel Open... BR Save £l Print
Le

Flow profiles up to 50 steps can be entered, saved as a file and printed out.

The start value, end value and the time to change from the start to the end value can be cre-
ated. It is important to respect the time format. When the profile is done, it can be saved (but-
ton Save) and the window is closed with the OK button.

It is also possible to open the created profile using the Open button.

Profile 2, Profile 3, etc. can be configured for Pump 2, pump 3, etc. respectively.

www.lambda-instruments.com
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Up to 10 channels can be displayed as curves. They show the set point values of the differ-
ent connected pumps and the actual value of integrators as a function of time.

In the curve, the legend displays the channel name, the unit and the last value. Time relates
to the last point entered.

To change the scale, double click on the axis. A second field is displayed into which the min-
imum and maximum values can be entered.

The A and - buttons reduce and enlarge the time interval and this A button displays a
ruler. The channel values are displayed in the legend and the corresponding time is dis-
played above right. This button inactivates the automatic curve renewal mode. It is possible

Ak
to return to this mode using the button.

Z Curves I ] [
A2 A A

Precitzet] Precitset2

o

25.03.2006 16:00:00

/

0004

7350

PrecifSet! PrecifSet2

S00-

1E3
250

T T T T 1
15:52:42 15:54:31 15:56:21 15:56:10 16:00:00
25032006 25.03 2008 25.03.2008 25.03.2008 25.03.2006

Time:

Curves showing the set points of the controlled pumps as a function of time.
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Channel choice

To select a channel click on the button. This opens a window in which the channel to be
displayed can be selected together with one of four axes and the curve colour.

( —
' Lea 5.6-PNet [Peristaltic Pump 2x configuration.cfg] | = | & x

[\

File Edition Confiuration Windows Help

—Channels Wisualisation
Pun Device Channel Axis Color

- |pump1 L] I — L]
|PumELocaI1 | — L.I
| -
| —-— |
| —-— |
| —-— |

PumpSet1

L

IntegrQtite

PumpSet2

m

InteqrQtite2

ol bl ol

|
|
I
|
|
|
I
|
!
I

M

X Cancel

"

Select a channel from the list, copy it into a field in the channel column with the ’>’ button.
Choose an axis (Y1 and Y2 are displayed on the left, Y3 and Y4 are displayed on the right).
Select a colour from the colour list. To delete a channel click on the ‘<’ button.

Automatic time interval

e
In this mode the new values are automatically added to the curves. The button '\’E is down.
The time on the top right is the time of the last added data point. The speed of the curve dis-
placement depends on the time interval.

To change this time interval, double click on the time axis; a new window appears. It contains
a time and a date, which correspond to the time at the left of the trend.

ey =
Auto time interval

—Beain

' OK
Date |12."U1a’14
Time  |16:0854 X Cancel

~Grid
n

www.lambda-instruments.com 8
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It is important to take care while formatting the fields. The date (DD/MM/YY format) and time
(HH:MM:SS) must have 2 characters (e.g. 01:58:09 08/01/14 = correct; 1:58:9 8/1/24 =
wrong). Clicking on the grid check box displays a grid.

It is also possible to change the time scale with the buttons 2 and ’B.

The time interval is limited to 3 days in this mode.

Fixed time interval

In this mode the curves are fixed. It is then possible to choose the time at the left and the
right of the trend. The rules for formatting the values are the same as for automatic time in-
terval.

XY

Fix Time Interval

Begin

« OK
- [12/01/14
Time  |16:28:58 ¥ Cancel

End-

|1 3/01114
Date
Tine |1 6:28:58

Grille
I

A

It is also possible to change the time scale with the buttons 2 and ’E}.

The time interval can be up to 60 days.

The ruler

Click on the al button. If the trend was in automatic time interval mode it will change to fixed
time interval mode so that the curves become fixed.

A black cursor appears at the left of the trend. Clicking with the mouse displaces the cursor.

The legend shows the value of the channels and the corresponding time at the right.

LA

When finished with this cursor, it can be deleted by clicking again on the
+—
'\’[ button.

button or pass

into automatic time interval mode by clicking on the

www.lambda-instruments.com 9
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Y axis

To change the scale of the Y axis double click on it. A new window appears which allows the
maximum and minimum values for the Y axis to be entered.

Intervalle Y ‘ 23

Min r—'g 0K
Mz I1 0 X Cancel

—Grille
o

The minimum value must be smaller than the maximal value. Clicking on the grid check box
shows a grid.

This option allows the channel values to be saved as a text file. Text files can be imported
into most office programs e.g. word processors, spreadsheets, databases etc.

A Exit the configuration (On the menu Configuration, select Exit) before data
saving.

[Mane]

Ennfig.l On |

To save channel values to a text file, click on the Config. button to open the 'Save data to text
file' window. Select the File tab and enter the file name and select the destination to save the
file.

o
b

v 0K X Cancel

A Lea 5.6-PNet [Peristaitic Pump 2x configuration.cfg] A Lea 5.6-PNet [Peristaitic Pump 2x configuration.cfg] = B %
File Ediion Configuration Windows Help | File_dtion _Confi Save data toa text e [MMMMMMMMMRN ==
Pump Profile 1 13 % - Bump B — _
P Pump Profile 2 3 2 ump
> . £ z . Fie | Channel| Time |
75{ Z75
Opt| > | |« opt| > | |« Q a Opt| » File name: Directory
oo 1] I o]
. - & a Testl bt CAPNet
5 5
I
| Integrator 1 Integrator 2
I
; I T P
I Run Reset Run Reset
I
I
0- 0-
I Save Data —
15:23:01 ™ = 5:23:01
: [None] 29102013 [TexCu kel 102013
I
|
I
I

www.lambda-instruments.com 10
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Then select the Channel tab and choose the channel for which the values need to be saved.
Select the Time tab, if it is necessary to record the time interval between two entries and the
time format.

2 2

A Lea 5.6-PNet [Peristaltic Pump 2x configuration.cfg) =] A Lea 5.6-PNet [Peristaltic Pump 2x configuration.cfg] =

Pump

Flo  Channel | Tine | . Flo | Chanel Time |

Device
Time:
€ Relative (5]

 {bsolute (date und ime]

PumpLocall
PumpSetl
PumpLocal2
PumpSet2

Time interval(1-3600 S)

00:00:30

Decimal separator
@ Pont

" Comma

VK X Cancel

For example: a period of 10 seconds will write a new line, every 10 seconds in the file. The
decimal separator for the saved values can also be chosen. This depends on the computer
configuration which will read the file. If the point is choosed and the PC uses comma as a
separator, the program (like Microsoft EXCEL,...) will probably interpret the values as a char-
acter chain and not as numbers. So the separator has to be chosen according to the needs.
Absolute time means that the recorded time contains the date and the time of the data. Rela-
tive time means that the time starts at 0.

The data will be saved from the moment the On button is pressed and the file name will be
displayed at the top.

R Lea 5.6-PNet [Peristaltic Pump 2x configurationcfa] [P A Lea 5.6-PNet [Peristaltic Pump 2x configuration.cfg] =
File Edition Configuration Windows Help | File Edition Configuration Windows Help
Pump Profile 1 Pump Profile 2 B b Pump Profile 1 Pump Profile 2 B 5
: E | = : E |z
L £ = . = 3
751 X715 F1s{ Z7s
Opt| » | |« Oopt| » | |« § 2 Opt| » | |« Opt| > | |« ] g
J _J 5 g JJJ __j _|_J 5 s
| 5 5
Integrator 1 Integrator 2 Integrator 1 Integrator 2
o = 0 = un || reset “run [ reset
0 i 0- 0-
Save Data o — Save Data —
15:23:01 15:23:01
Testl.td 291012013 [None] 291102013
on Config | On
-1 <
v v
i it

To stop saving the data click the On button once again, and [None] will be displayed at the
top. If data storage is stopped, it is impossible to save further data.

www.lambda-instruments.com 11
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These devices are not connected to the computer, they are functions that manage one or
more channels.

df/dt function

Enter the calculation interval in seconds. The larger it is, the less background noise there will

be. Then enter the Factor (dependent on whether the unit is in: h™, min™, s™) and select the
channel to be linked from the list.

F e ™
Caonfiguration for dffdt function _ ﬁ

Device

Narne dfdtFunction

Calculation
Perniod (1-3600 sec) 10

Factar
@ second () mirwte: () hour

Linked channel

[ [Mane] -

Channels

Drescription

dfdtFunction

Infarmation

l ¢DK l l x Cancel

The channel buttons allow each channel to be individually configured. The Description field
displays the internal device name. The Information field is free for user input.

www.lambda-instruments.com
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Timer
This function allows a time to be displayed. This device functions like a stop watch.

~ -
Configuration for a tim_eL- u

Device

Mame Timer1

Channels

RunTimerl ][ ResetTimerl ][ Timeryaluel

Descriphion

Timerl

Infarmation

| [ x Cancel

The channel buttons allow each channel to be individually configured. The Description field
displays the internal device name. The Information field is free for user input.

Pulse function
This function allows a pulse to be generated.

Select the output to be accessed from the list and enter the minimum and maximum values
together with the times (hours, minutes and seconds) from the two states of the output. For
digital outputs enter the values 0 and 1. The output values for start and stop can also be se-
lected with this function.

Devics Channels
PulsFunctionl
Wewa RunPulsfetl || Pulsvaluet
Off State
Duslon 0000001 Vahe O B0
PulsFunctianl
On State
Duration 000:00:01 Vale 0 Irfermetian
Start with
() O value (@ On value
Stop with
@ 0OIf value () Dnvalue
Linked channel
[Nane] -
‘ o 0K ‘ I * Cancel

The channel buttons allow each channel to be individually configured. The Description field
displays the internal device name. The Information field is free for user input.

www.lambda-instruments.com 13
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Profile

Device Profile. pif
Profile

Narme
Time [HHH:MM:55] =
[

. |
Linked channel 000:00:00 i

000:00:00

G55etTotFlowl r 000:00:00
Charinels G55etTotFlowz B
GSSetTotFlows 000:00:00

StartProfile] || GS5etT otFlovd
[ starPofiet ]| ESSerTol 0000000

MazsfSet10
MassfSetll 000:00:00

Drezcription a00:00:00
Profile

000:00:00
" 000:00:00
Informatiorn

000:00:00
000:00:00

Remarks

l W 0K l l ¥ Cancel l By Open.. H B Save.. H E Fiint ]

Enter the 'begin' and 'end' values and the duration. The format for duration must be correct:
use three figures for hours and two for minutes and seconds respectively. If the duration is
set to zero the segment will be ignored.

The 'begin’ and 'end' values must be in the same interval, as defined for output. Then select
the output to be accessed from the list. It is possible to configure a ramp without linking to a
channel (none in the list). A ramp can be configured using the programming language.

Program

The programming language is a very advanced tool, which can be used to create control al-
gorithms and on-line simulations.

Confiquration:

A value can be calculated using this channel. Enter the unit together with the maximum and
minimum value of the result. All values which are outside this range will be rounded up to the
limit value.

These fields must be filled out even when the there is no result to be calculated.

A program can have up to 900 characters, which corresponds to 40 - 50 lines.

www.lambda-instruments.com 14
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Device Program

Name Programl

Channels

Drescription

Frogrami

Information

| ¢DK | l x Cancel

When all the values have been entered click on OK to confirm and save the configuration.

Programming language syntax:

The syntax analyser does not differentiate between lower case and capital letters e.g. pH1,
phl, and PH1 when represented in the same channel.

Reserved words

- activate, begin, boolean, else, end, getcontroller Y, getval, hi, hihi, if, init, lo, lolo, loop,
program , quit, real, reset, setval, start, stop, then, var.

These words may not be used as channel or variable names.

Program structure

The program is divided into three parts which must not necessarily be present at the same
time.

Initialising blocks

The instructions are only carried out when the pro-

gram is started.
Syntax

init
begin

Instruction
end;

www.lambda-instruments.com 15
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Ending blocks
The instructions are only carried out when the pro-
gram is stopped.
Syntax
quit
begin
Instruction
end;
Cyclic blocks
The instructions are carried out cyclically ca. every
second.
Syntax
loop
begin
Instruction
end;

Internal variables
These can be declared as command lines or Boolean (true / false).
Syntax

var’ variable name variable type’;

Instructions

There is a semicolon at the end of an instruction.

Assignment ‘:=’

The terms on each side of the character must be the same. The channel values are assumed
to be Real, together with those from digital channels 0 or 1.

Conditional statements
Syntax
if condition then instruction else instruction;

If the condition after 'if' is true, then the instruction is carried out after 'then’, otherwise the
instruction is carried out after 'else’. 'Else’ is not obligatory (consequently no further instruc-
tion is necessary). Caution, the equals test is written ‘=" and not “:=’.
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Operators
+, -, %,/
AND, OR, NOT
= > <, >= <=

The values allowed range from -10000 to -0.00001 and from 0.00001 to 10000. The value 0
is also allowed except for a division. If a calculation results in a value outside this range the
program is automatically stopped.

Procedures

Channels can be accessed in order to change a target value, start a ramp etc. Lower or up-
per case characters may be used.

SetVal (channel name, comma value)

The channel must be a digital or analog output or a program channel.

Functions

Functions deliver values which are mainly comma values that can be assigned to a variable
or a channel.

GetVal(channel name)

This command allows access to values from digital or analog inputs and outputs, sample
management channels, weight measurements etc.

The values supplied are real.

Error management

After pressing the OK button the program syntax is checked; if an error is found an error
message is displayed.

www.lambda-instruments.com 17
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The alarm and report windows are always available, they cannot be closed.

Alarm window
Operation:

& Alarms E'@
|

Delete all Acknowledge

When an alarm is triggered the date, time, channel name and value are automatically en-
tered into the alarm list. To cancel an acoustic alarm, press the Acknowledge button.

After an alarm has been acknowledged it can be deleted from the list selecting the alarm
from the list and pressing the Delete button. It is recommended that the list of alarm messag-
es is deleted from time to time as they take up storage capacity.

Buttons and Icons:

Print out the contents of the window

% Acoustic alarm

. Optical alarm
[z
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Report window

Operation:

This window functions like a simple text editor. Individual remarks can be written here.
& Report [E=8 ol =<
=N-

Additionally most user interventions are automatically entered and it is also possible for the
user to enter these messages:

- Controller and function start and stop
- Alarms

Buttons and Icons:

opens a text file (*.txt)

Save text to a file

Print out the contents of the window

@

www.lambda-instruments.com
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The channel values are saved in RAM. When the computer is switched off all the data are
lost. It is however possible to save the data to a file and manipulate them at a later date with
other programs. A program to convert the data into ASCII code is supplied as part of the
package.

Data history function

The channel values are stored in a circular buffer. When this is full the oldest data are over
written. To prevent the buffer from filling up too quickly only data which has been changed is
saved.

Example:

If the temperature remains constant for 2 hours only one point is saved In addition some of
the channels may have a lot of background noise. To prevent the buffer from filling up too
quickly only data which have been changed are saved when the time difference is > 8 sec-
onds.

Pictorial representation of data history function

When data are saved to a file the system searches the circular buffer once a minute for new-
ly entered data and copies them to a file.

Channel values

if the value has changed and more than
l l l l 8 seconds have elapsed since the last entry

Historical
memory with
fixed size

N~

every
minute

File File

Amount of data can |conversion

be very large program data in ASCII format

—»

compressed data —_— many
commercially
available
programs
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Troubleshooting
If the set value Y is not accepted by the system:

Check the minimum and maximum values of the set value
Files

Lea.exe

Quickchimes.wav (Sound file for alarms)

Occupied communication interfaces

COM1
com2
COM3
cow4
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